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GEOSYSTEMS

UAV Workfow 

The GEOSYSTEMS UAV Workflow supports the computation of digital ortho mosaics, digital elevation 
models, point clouds and 3D meshes from overlapping image data captured with frame cameras and RPC 
based line scanners from within the ERDAS IMAGINE Spatial Modeler. 

ERDAS IMAGINE UAV Feature Overview 

The ERDAS IMAGINE UAV operators for the ERDAS IMAGINE Spatial Modeler enable you to create an 
ortho-mosaic, a photogrammetric point cloud, a digital surface model (DSM), and a 3D mesh out of UAV 
still images. Both the image alignment as well as the creation of the outputs are fully automated. You can 
project the results to a coordinate system specified by an EPSG. 

 

 

Section 1 

ERDAS IMAGINE UAV Feature 

Processing Workflow Concept 

There are four main processing steps which you can identify by opening the underlying spatial model of 
the UAV workflow: 

1. The first step creates a new UAV project. You need to specify the image data and the orientation 
information.  

2. The next step computes the image orientation. During this process, the system searches for common 
points in the input images, identifies the position of the camera for each picture, and refines camera 
calibration parameters. The results are a sparse point cloud and a set of camera positions. You need 
to define the level of accuracy as well as the preselection parameter for the image matching. 

3. The Compute Surface operator creates a 3D polygonal mesh. Based on the estimated camera 
positions and image data, a dense point cloud is generated first. This is then used as input for the 
creation of a 3D polygonal mesh representing the object surface described by the point cloud. For this 
operator you need to set several parameters that are influencing the quality of the point cloud and of 
the 3D surface as well as the computation time. 

4. The last step produces the final output dataset or datasets. You can also reuse all results created in 
the model to create a complex workflow like an image classification based on the UAV datasets. 

a. Export Mosaic allows you to export the computed surface as a digital ortho mosaic. The export 
supports the image file formats ECW, JPEG2000, IMG and TIF. 

b. Export DEM allows you to export the computed surface as a digital elevation model. The export 
supports the image file formats ECW and TIF. Additionally, you can also create and export contour 
lines as shape file. 

c. Export PointCloud allows you to export the computer point cloud to several point cloud format 
such as Wavefront OBJ format, Stanfort PLY format, XYZ point cloud format, ASPRS LAS 
file, LAZ format, U3D format, Adobe PDF format, ASTM E57 format, Agisoft OC3 format, 
Potree format,Topcon CL3 format, Cesium 3D tiles format, ASCII PTS format, Autodesk 
DXF format. 
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d. Export LAS allows you to export the computed point cloud as LAS file with RGB encoding. 

e. Export Model allows you to export the computed surface model to several model formats such as 
Wavefront OBJ format, 3DS model format, VRML model format, COLLADA format, Stanfort 
PLY format, STL model format, Alembic format, Autodesk FBX format, Autodesk DXF 
Polyline format, Autodesk DXF 3DFace format, U3D model format, Adobe PDF format, 
Google Earth KMZ format, Binary glTF model format, X3D model format. 

f. Export TiledModel allows you to export the computed surface model to several tiled model 
formats such as Cesium 3D Tiles format, Scene Layer Package format, PhotoMesh Layer 
format, Agisoft Tiled Model format, Agisoft Tile Archive format. 

g. Export Project allows you to save the Metashape project to several other project file formats such 
as Agisoft XML format,CHAN files format, Boujou format, Bundler format, Omega Phi 
Kappa format, PATB project format, BINGO project format, ORIMA format, AeroSys exterior 
orientation format, Inpho project file format, Summit evolution project format, Blocks 
Exchange format, Realviz RZML format, VisionMap format format, Alembic format, 
Autodesk FBX format.  

h. Export Block File allows you to export the oriented image block as an IMAGINE Photogrammetry 
block file BLK. 

IMAGINE UAV Menu 

The IMAGINE UAV menu is located in the Toolbox tab. 

  The IMAGINE UAV menu contains the following functions 

 

 

1. Run UAV Process 

Click Run UAV process and the Spatial Model dialog opens. There are the options to either run a default 
UAV model or to execute the process based on specified input parameters for a customized model. This 
means that the base functionality is also available for IMAGINE Essentials users that are only able to 
execute and not to create or open Spatial Models for viewing. Thus, this dialog enables the user to specify 
all relevant parameters via a graphical user interface. For more information, see also Step-by-Step guide 
for the IMAGINE UAV Workflow starting on page 73. 
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Image Input Options: 

 

1. Select the directory containing the imagery to be processed. 

2. Define the pattern that is used to select images inside the provided input folder. The entered 
pattern is interpreted as wildcard matching pattern to select files. The default value is *.jpg, which 
selects all JPG-images. 

Hint: Image pattern 

Character Description 

? Matches any single character, identical to full regular expressions. For example, 
DSC_123?.jpg selects files such as DSC_1231.jpg, DSC_1232.jpg or DSC_1233.jpg. 

* Matches zero or more of any characters, identical to full regular expressions. For example, 
DSC_123*.jpg selects files such as DSC_123.jpg, DSC_1232.jpg or DSC_12345.jpg. 
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[...] Sets of characters can be represented in square brackets, similar to full regular 
expressions. For example, DSC_123[3-5].jpg selects only the files DSC_1233.jpg, 
DSC_1234.jpg or DSC_1235.jpg. 

 

Orientation: 

 

3. Select the suitable Orientation Format from the listbox that contains all available orientation 
sources or formats. Select From Exif to take the orientation information directly from the image 
data. In this case, the presence of the Exif data is validated for each selected image file. Select 
From GPS track to take the orientation information from a GPX track file. For RPC based satellite 
images select From RPC txt.  Any other format in the list refers to custom formats of orientation 
data. 

4. Select a text file containing the orientation data. This file is only required when selecting a custom 
orientation data format. Select the GPX-Track file when choosing From GPS track as orientation 
format.  

5. This option allows you to specify a time offset when using a GPX file. In case of an offset between 
image recording and GPS time, please specify the time difference between image recording and 
GPS time. How much later or earlier have the images been recorded with respect to the GPS 
time? This is necessary to determine the correct position data from the provided GPX file. 
Default: ‘+00:00:00’. 

6. This option toggles the handling of images with missing orientation data. If false (default value), 
all images must have orientation data. If true, also images with missing orientation data are 
processed. The minimum number of images that must have orientation data (absolute and 
relative, with the larger number used) can be specified in the IMAGINE Preferences. 

 

Accuracy of Camera Position and Rotation Angles: 

 

7. Specifies the accuracy of the recorded camera position in X/Y in meters or in Latitude/Longitude 
in degrees. Leave the default (5 meters) for consumer GPS receivers. If more accurate GPS 
recordings are available, it is important to set them here, as the geo-location of the final products 
will benefit substantially. 

8. Specifies the accuracy of the height component of the recorded camera position in meters. Leave 
the default (5 meters) for consumer GPS receivers. If more accurate GPS recordings are 
available, it is important to set them here, as the geo-location of the final products will benefit 
substantially. 
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9. Specifies the accuracy of the recorded camera rotation angles in degrees. Leave the default (2 
degrees) for consumer IMU devices. If your orientation data do not include rotation angles, this 
value will be ignored. 

 

Computation Options: 

 

10. The Orientation Presets allow the user to change the default computation settings from aerial to 
terrestrial. This will change Image Preselection and Surface Mode to a suitable value. 

11. The parameter Image Preselection determines how overlapping image pairs are found, which 
has a significant influence on the computation time, especially for large sets of image data.  

Value Description 

Disabled No preselection is executed. All possible image pair combinations are 
computed, resulting in a longer computation time. 

Generic The preselection is based on image correlation in lower resolution images. 
For large image datasets this can still consume a significant amount of time 
as all combinations of image pairs are being evaluated. 

Ground Control If ground control information (initial camera orientation data) were specified 
during project creation, this information is used to reduce the number of 
image pairs that are evaluated, thereby improving the computation time. 

12. The parameter Surface Quality influences the level of detail of the reconstruction. A higher value 
results in a more detailed reconstruction but can take a very long time to produce results. A lower 
value produces a coarser reconstruction, but computation time is much shorter. 

Value Description 

Lowest, Low, Medium Creates less detailed point clouds but computation time is relatively 
short. Should be used only to get a quick impression of the surface. 

High Creates a detailed reconstruction of the surface. If nothing gets 
selected this value is default. 

Ultra Creates a very detailed reconstruction of the surface but increases 
the chance of outliers. Additionally, the computation time is 
significantly longer than using high. 

13. Use the parameter Mode to select the type of surface to be computed. Height Field allows you to 
model planar surfaces. Use this default when dealing with UAV data. Arbitrary can be used to 
model any type of surface. Typically, this value only must be selected if objects like buildings or 
statues are being reconstructed. 
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Output Options: 

 

14. If the point cloud was reconstructed from image data with known camera positions and the 
parameter EPSG is provided, all output datasets will be re-projected to the specified coordinate 
system. 

15. Select if you want to create a point cloud as output. If so, enter the filename for the output LAS 
file. 

16. Select if you want to create a DSM (a raster file based Digital Surface Model) as output. If so, 
enter the filename for the output DSM file. Valid data types are *.tif and *.img. The output file will 
have a bit depth of 32 producing float data type. For all output images, pyramid files are 
computed automatically. To change the ground sampling distance of the exported DSM change 
the resolution type to Specify and enter the desired resolution in meters. Keep Original to 
automatically compute the resolution based on the data. 

17. Select if you want to create a mosaic as output. If so, enter the filename for the output mosaic file. 
Valid data types are *.tif, *.img, *.ecw and *.jp2. For all output images, pyramid files are computed 
automatically. To change the ground sampling distance of the exported mosaic file change the 
resolution type to Specify and enter the desired resolution in meters. Keep Original to 
automatically compute the resolution based on the data. 

 

 

 

 

 

Optional: Network processing Tab 
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18. Select the option Distribute processing over network nodes to utilize all configured network 
nodes for the computation of the project. For more details. please see section 4. 

19. Specify the Master server of the configured processing cluster. This master server acts as the 
central component of the cluster and must be available from all nodes via TCP/IP and the 
specified port. 

20. Specify the Serer port on which the master server is listening for connection from the configured 
processing nodes. 

21. To allow several processing nodes to work simultaneously on the same project, all raw data must 
be stored below the specified Root folder. Further separating in subfolders is allowed. The Input 
Folder selected under 1) has to be a subfolder of this root folder. 
 

Optional: Marker Tab  

 

22. Select the option Use Marker to introduce automatic ground control within your project. This 
information will be used to improve the overall positions of your images (e.g. if you do not use 
precise GPS-information). 
In order to use this additional information, you need to print and to place Coded targets (CTs) 
before acquiring the images. Each coded target has a ring parted in black and white segments 
around the central full circle and will be recognized by the program within the picture 
automatically. For each CT you need to define a geo-coordinate that will be used as reference 
coordinate within your image block. 

23. Specify the file format containing the reference coordinates of your markers. The coordinates will 
be transformed in the background if the projection of the file is different to the reference system 
used in your project. 
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24. Select the file that contains the reference coordinates (see specifications at the end of this 
document under Using markers (Coded Targets) 

25. Select the precision of the measurements for your reference coordinates in X and Y direction. 

26. Select the precision of the height measurements for your reference coordinates.  

27. Select the pattern used to identify the CTs. 

28. Select the tolerance used to detect the CTs in your images. Try to increase this value if the 
markers are not well detected. 

 

 

2. View model  

Click View model to open the default UAV Model in the Spatial Modeler Editor, where you can modify or 
extend the UAV model. Spatial Modeler Editor requires an ERDAS IMAGINE Professional level license. 
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3. Edit Orientation Formats and Mark File format 

Click Edit orientation formats to open the Orientation data formats dialog to extend the list of supported 
orientation data formats. This dialog is also used to define the file format for the marker reference file. For 
an example, please see the Step-by-Step guide for the IMAGINE UAV Workflow on page 73. 

 

 

4. UAV Exports 

Click UAV Exports to run an additional model allowing you to export all different output types/formats 
supported by IMAGINE UAV including various point cloud formats, DSM, ortho mosaic, various 3D-Model 
formats and photogrammetric outputs to a variety of project formats. To use this export dialog/model an 
already triangulated UAV project created using the Compute Orientation Operator or Compute Surface 
Operator) is needed. 

The UAV Exports dialog has several tabs, grouping thematically the possible outputs.  
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4.1 Input and Report 

 

1. Select an existing project file which will be generated during the base processing steps in the 
input folder of your raw image data. For the export the file projectFILE.psx must be selected. It 
contains the fully triangulated project. 

2. Set the EPSG code for all exports. Use a valid projected coordinate system EPSG code. All 
different export types will be re-projected if the output EPSG differs from the project EPSG. 

3. Select the option Distribute processing over network nodes to utilize all configured network 
nodes for the computation of the project. For more details. please see section 4. 

4. Specify the Master server of the configured processing cluster. This master server acts as the 
central component of the cluster and must be available from all nodes via TCP/IP and the 
specified port. 

5. Specify the Serer port on which the master server is listening for connection from the configured 
processing nodes. 

6. To allow several processing nodes to work simultaneously on the same project, all raw data must 
be stored below the specified Root folder. Further separating in subfolders is allowed. The Input 
Folder selected under 1) has to be a subfolder of this root folder. 

7. Select this option to export the triangulation report for your project as PDF.  

8. Specify the file to export the report to. 
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9. Provided title for exported report. When no title is provided, the default of Metashape is used. 

10. Provided additional description for exported report. When no description is provided, the default of 
Metashape is used. 

4.2 Primary Outputs 

 

1. Select this option to export the point cloud data of your project. 

2. Select the desired Pointcloud Format for the export. The following formats are available: 
Wavefront OBJ format, Stanfort PLY format, XYZ point cloud format, ASPRS LAS file, LAZ 
format, U3D format, Adobe PDF format, ASTM E57 format, Agisoft OC3 format, Potree 
format, Topcon CL3 format, Cesium 3D tiles format, ASCII PTS format, Autodesk DXF 
format. Saving color information of the point cloud is not supported by the OBJ and DXF formats. 

3. Specify the file name to export to pointcloud data to. 

4. Select this option to export a DSM (a raster file based Digital Surface Model). 
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5. Specify the filename for the output DSM file. Valid data types are *.tif and *.img. The output file will 
have a bit depth of 32 producing float data type. For all output images, pyramid files are 
computed automatically. To change the ground sampling distance of the exported DSM change 
the resolution type to Specify and enter the desired resolution in meters. Keep Original to 
automatically compute the resolution based on the data. 

6. To generate and export contour lines, select the option Export Contours. 

7. Specify the filename for the Contour File to be generated. Only supported format is shp.  

8. Select which geometry type to use when exporting the contour lines. Default is Polyline. 

9. Specify the Interval between two contour lines to be generated. The unit refers to the unit of the 
underlying elevation data used. In most cases that will be meters.  

10. Select this option to export an ortho mosaic.  

11. Specify the filename for the output mosaic file. Valid data types are *.tif, *.img, *.ecw and *.jp2. For 
all output images, pyramid files are computed automatically. To change the ground sampling 
distance of the exported mosaic file change the resolution type to Specify and enter the desired 
resolution in meters. Keep Original to automatically compute the resolution based on the data. 

4.3 Surface Outputs 

 
 

1. Select this option to export the 3D-Meshes of your project. 
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i. Select the desired 3D-Model Format for the export. The following formats are available: 
Wavefront OBJ format, 3DS model format, VRML model format, COLLADA format, Stanfort 
PLY format, STL model format, Alembic format, Autodesk FBX format, Autodesk DXF 
Polyline format, Autodesk DXF 3DFace format, U3D model format, Adobe PDF format, 
Google Earth KMZ format, Binary glTF model format, X3D model format. 

2. Specify the file name to export to 3D mesh data to. 

3. Select texture mapping strategy to determine how the object texture will be packed in the texture 
atlas. Proper texture mapping mode selection helps to obtain optimal texture packing and, 
consequently, better visual quality of the final model. Possible options are:  

a. Generic: it allows to parametrize texture atlas for arbitrary geometry. No assumptions 
regarding the type of the scene to be processed are made; program tries to create as 
uniform texture as possible. 

b. Orthophoto: this mapping strategy textures the whole object in the orthographic 
projection. It produces even more compact texture representation than the Adaptive 
orthophoto mode at the expense of texture quality in vertical regions. 

c. AdaptiveOrthophoto: this mapping strategy splits the object surface into a flat part and 
vertical regions. The flat part of the surface is textured using the orthographic projection, 
while vertical regions are textured separately to maintain accurate texture representation 
in such regions. With this mapping strategy, the program tends to produce more compact 
texture representations for nearly planar scenes, while maintaining good texture quality 
for vertical surfaces, such as walls of the buildings. 

d. Spherical: this mapping strategy is appropriate only to a certain class of objects that have 
a ball-like form. 

4. Select this option to include the textures in the export. Some file formats (Wavefront OBJ, 3DS 
model, VRML model, COLLADA, Stanfort PLY, Autodesk FBX) save the texture image in a 
separate file. The texture file should be kept in the same directory as the main file describing the 
geometry. 

5. Select the image format of the exported textures. Supported formats are: JPEG, TIFF, PNG, 
BMP, EXR, TGA, JP2. 

6. Select this option to export the 3D-Meshes of your project as Tiled Model. 

7. Select the desired Tiled 3D-Model Format for the export. The following formats are available: 
Cesium 3D Tiles format, Scene Layer Package format, PhotoMesh Layer format, Agisoft 
Tiled Model format, Agisoft Tile Archive format. 

8. Specify the file name to export to tiled 3D mesh data to. 

9. Select the Datasource for the tiled model export. Available formats are PointCloud and Mesh. 

10. When selecting a ZIP based tiled model, select also the underlying mesh format. The available 
formats are identical to the 3D-Model export. 

11. Specify the tile size of the exported tiled model in pixels. 
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4.4 Photogrammetry Outputs 

 

1. Select this option to convert and export your project to another photogrammetric project format. 

2. Select the desired Project Format to convert and export to. The following formats are available: 
Agisoft XML format,CHAN files format, Boujou format, Bundler format, Omega Phi Kappa 
format, PATB project format, BINGO project format, ORIMA format, AeroSys exterior 
orientation format, Inpho project file format, Summit evolution project format, Blocks 
Exchange format, Realviz RZML format, VisionMap format, Alembic format, Autodesk FBX 
format. Exports to Bundler and Boujou formats will save sparse point cloud data in the same file. 
Export to Bundler format is not saving distortion coefficients k3, k4. 

3. Specify the file name to export the converted project data to. 

4. Tick this option to include already computed tie points in the export. Exports to BINGO, ORIMA, 
PATB, Summit Evolution and Blocks formats allow to store tie points. 

5. Tick this option to include markers in the export. 

6. Specify the rotation order (CHAN format only). 

7. Select this option export your project as IMAGINE Photogrammetry Block file (BLK).  
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8. Specify the file name for the block file. 

9. Enable this flag to export all tie points used for the triangulation. 

10. Tick option to include a reference DEM/DSM. 

11. Specify the DEM/DSM file that will be added to the BLK file. It is advisable to use only DEM/DSMs, 
which contain information about the elevation reference to avoid misalignments. For best results, use 
directly the output created within the project. 

 

IMAGINE UAV Layout 

A new GEOSYSTEMS UAV Workflow Layout is added during the installation of the IMAGINE UAV 
package. It is a simplified toolbar and contains the most important functions needed for the UAV data 
processing. To apply this layout, click File > Layout and select the GEOSYSTEMS UAV Workflow 
layout.  
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Section 2 

Create Project 

Category: GEOSYSTEMS UAV 

Default ports All available ports 

 

 

 

Description 

Creates a new UAV project based on the selected image data. Image data can be distributed over several 
folders, can refer to several cameras or even belong to multispectral bands. The layout how to interpret 
the provided image data is specified via the port parameter ‘CameraLayout’. By default, a single camera 
(SingleCameraLayout) is assumed.  

The following camera layouts are supported: 

- SingleCameraLayout: All images provided are imported, so that they refer to a single 
camera even when they are stored in several folders. If Metashape automatically 
determines several cameras from the provided image data (e.g. different sensor sizes) 
the layout will be kept and turn automatically in a ‘MultiCameraLayout’. The number of 
images, types of orientation formats and orientation data sources can vary for each folder. 
An example for this camera layout is the usage of one UAS or terrestrial camera 
recording imagery for one scene or object. 

- MultiCameraLayout: Imported images from different folders are assigned to separate 
cameras (one camera per folder). If only one folder is used for importing, by default all 
images will only be linked to a single camera and the layout will turn automatically in a 
‘SingleCameraLayout’. The number of images, types of orientation formats and 
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orientation data sources can vary for each folder. An example for this camera layout 
would be the usage of several UAS recording imagery for one scene or object and even 
mixing in terrestrial images for the same scene or object. 

- RigidCameraLayout: This camera layout is like the MultiCameraLayout specifying one 
camera per folder but assuming a rigid relative position of the cameras to each other for 
all recoding positions. An example would be a UAS with several cameras on board 
recording imagery for one scene or object. For this camera layout the number of images 
per folder must be identical. It is assumed that the order of images in each folder is 
identical so that all first images belong to one rigid position, all second images belong to 
one position, … Types of orientation formats and orientation data sources can vary. 

- MultibandCameraLayout: With this camera layout multispectral recordings saved in 
individual image files can be imported und used for 3D reconstruction. Each provided 
folder will be linked to one band. For this camera layout the number of images per folder 
must be identical. It is assumed that the order of images in each folder is identical so that 
all first images belong to one position, all second images belong to one position, … Types 
of orientation formats and orientation data sources can vary. 

To activate the network processing, toggle the visibility of the NetworkProcessing port and connect the 
output of the Network Processing operator with it. The parameters specified on the Network Processing 
operator must refer to a configured and available cluster of processing nodes and master server. Please 
see section 3 for more details. 

 

To specify more than one folder (and the associated orientation data) use  in the ribbon interface. 
A block of ports will be added, allowing the specification of all necessary data for the new folder.  

 

 

 

 

 

 

 

 

→ 

 

 

 

Use  to remove the last group of port respectively.  

The following port descriptions hold of all groups of added ports. 

Image files are taken from the provided directory, considering the entered wildcard pattern. Orientation 
data can be taken directly from the image data itself (EXIF information of Longitude, Latitude and Altitude) 
or read from any table-like text file containing a column with the image file names. The list of supported 
text file formats for the orientation data can be dynamically extended. 

Double click on the port OrientationFormat to open a dialog with the available orientation sources or 
formats. Select From Exif to take the orientation information directly from the image data containing Exif 
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information. In this case, the presence of the Exif data is validated for each selected image file. Select 
From GPS track to take the orientation information from a GPX track file.  

Select From RPC txt to handle RPC based satellite data. This will automatically change the used camera 
model to a line scanner. Text files (*.txt) with the according RPC parameters are read automatically when 
in the original location and format.  

Any other format in the list refers to custom formats of orientation data. If one of them is selected, the 
actual text file with the orientation data has to be provided using the port OrientationDataFile. 

 

 

To define a new format for the orientation data stored in a text file, click the Edit orientation formats 

button . 
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Orientation Formats 

Value Description 

From Exif Takes the orientation data directly from the image 
files by extracting the Exif information. The 
presence of the Exif data is validated for each 
selected image file. 

From GPS track Instead of providing the orientation data already 
linked to each image file, you can also ingest a GPX 
track file with GPS recordings and relevant time 
information. It is important that your image data 
contains a correct time stamp, which is used to 
interpolate the according GPS information from the 
track file. See the port TimeCorrection to specify 
the time offset between your image data and the 
GPS recordings. 

From RPC txt When using RPC based satellite data (line 
scanners), select this option to load the sensor 
model data form the accompanying rpc text files.  

<custom formats> Any of customer-defined format of text-based 
orientation data files. 

In order to define your own custom orientation data format, refer to ERDAS IMAGINE UAV Workflow 
"Step-by-Step guide for the IMAGINE UAV Workflow" on page 57. 

Image pattern 

Character Description 

? Matches any single character, identical to full regular 
expressions. For example, DSC_123?.jpg selects files such 
as DSC_1231.jpg, DSC_1232.jpg or DSC_1233.jpg. 

* Matches zero or more of any characters, identical to full 
regular expressions. For example, DSC_123*.jpg selects 
files such as DSC_123.jpg, DSC_1232.jpg or 
DSC_12345.jpg. 

[...] Sets of characters can be represented in square brackets, 
similar to full regular expressions. For example, 
DSC_123[3-5].jpg selects only the files DSC_1233.jpg, 
DSC_1234.jpg or DSC_1235.jpg. 

Connections 

Name Objects Supported Description Required 

ImageDirectory[2,..] Directory Directory containing the imagery to be 
processed.  
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ImagePattern[2,..] String Pattern to use to select images inside 
the provided ImageDirectory. The 
entered pattern is interpreted as 
wildcard matching pattern to select 
files. The default value is *.jpg, which 
selects all JPG-images. 

 

OrientationFormat[
2,..] 

String/Enumeration Specifies the source/format to take 
orientation data from. If not specified, 
FromExif is used. The list of supported 
orientation data formats can be 
extended dynamically. 

 

OrientationDataFile
[2,..] 

File Text file with orientation data. This file is 
only required when selecting a custom 
orientation data format. 

 

OriDataIncomplete Boolean Toggles the handling of images with 
missing orientation data. If false 
(default value), all images must have 
orientation data. If true, also images 
with missing orientation data are 
processed. The minimum number of 
images that must have orientation data 
(absolute and relative, with the larger 
number used) can be specified in the 
IMAGINE Preferences.  

 

AccuracyXY[2,..] Double Specifies the accuracy of the recorded 
camera position in X/Y in meters or in 
Latitude/Longitude in degrees. Leave 
the default (5 meters) for consumer 
GPS receivers. If more accurate GPS 
recordings are available, it is important 
to set them here, as the geo-location of 
the final products will benefit 
substantially. 

 

AccuracyZ[2,..] Double Specifies the accuracy of the height 
component of the recorded camera 
position in meters. Leave the default 
(5 meters) for consumer GPS receivers. 
If more accurate GPS recordings are 
available, it is important to set them 
here, as the geo-location of the final 
products will benefit substantially. 

 

AccuracyAngles[2,.
.] 

Double Specifies the accuracy of the recorded 
camera rotation angles in degrees. 
Leave the default (2 degrees) for 
consumer IMU devices. If your 
orientation data do not include rotation 
angles, this value will be ignored. 
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TimeCorrection[2,..] String/TimeCorrection In case of an offset between image 
recording and GPS time, please specify 
the time difference between image 
recording and GPS time. How much 
later or earlier have the images been 
recorded with respect to the GPS time? 
This is necessary to determine the 
correct position data from the provided 
GPX file. Default: ‘+00:00:00’. 

 

UAVProject UAVProject The created UAV project that can only 
be used as input for the subsequent 
UAV operator Compute Orientation. 
After a successful execution, the file 
projectFile_initial.psx is created in the 
ImageDirectory. 

 

 

Syntax 

CreateProject ( <ImageDirectory> , <ImagePattern>, <OrientationFormat>[, 

OrientationDataFile=<OrientationDataFile>][, 
OriDataIncomplete=<OriDataIncomplete>] [, AccuracyXY=<AccuracyXY>] 
[,AccuracyZ=<AccuracyZ>] [,AccuracyAngles=<AccuracyAngles>] 

[,TimeCorrection=<TimeCorrection>] ) 

 
 

Load Project 

Category: GEOSYSTEMS UAV 

 

 

Description 

Loads an existing UAV project from disk. This operator is only provided for convenience to allow loading of 
an already processed UAV project. You can use it to reload the result of a specific processing step and 
then continue without re-processing. The project files to load are located in the directory containing the 
actual image data. The following (interim) results can be reloaded.  
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Project Files on Disk 

Project File Name Description 

projectFile_initial.psx Result of the Create Project Operator. When 
selecting this file, you can skip the Create 
Project step. You can use the loaded project 
directly as input for the Compute Orientation 
Operator. 

projectFile_ori.psx Result of the Compute Orientation 
Operator. When selecting this file, you can 
skip the Compute Orientation step. You can 
use the loaded project directly as input for the 
Compute Surface Operator. 

projectFile.psx Result of the Compute Surface Operator. 
When selecting this file, you can skip the 
Compute Surface step. You can use the 
loaded project directly as input for the export 
operators Export Mosaic Operator, Export 
LAS Operator and Export DEM Operator. 

 

Connections 

Name Objects Supported Description Required 

ProjectName File File name of the project to be loaded from 
disk.  

UAVProject UAVProject Loaded UAV project which can be used as 
input for the according subsequent UAV 
operators (see table above). The process will 
fail if used as input for any other UAV operator 
as stated in the table above. 

 

 

Syntax 

LoadProject ( <ProjectName> ) 

 

Define Camera Calibration 

Category: GEOSYSTEMS UAV 

Default ports All available ports 
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Description 

Allows the user to define a new camera calibration by specifying the mandatory camera calibration 
parameters (coordinates of the principal point). Additionally, the sensor pixel size must be provided 
(specified in millimeter).  

 

Connections 

Name Objects Supported Description Required 

FocalLength Double The focal length (z coordinate of principal 
point) of the camera in unit specified on port 
Unit. 

 

Cx Double X coordinate of principal point of the camera 
in unit specified on port Unit.  

Cy Double Y coordinate of principal point of the camera 
in unit specified on port Unit.  

Unit String/Enumeration Unit of the provided principal point 
coordinates. Either Millimeter or Pixel  

PixelSizeX Double The sensor pixel size in millimeter in x. If 
PixelSizeY is not provided, the specified 
value will be used for x and y.  

 

PixelSizeY Double The sensor pixel size in millimeter in y. If not 
provided, PixelSizeX will be used for y as 
well. 

 

UAVCalibration
Data 

UAVCalibrationData The created UAV camera calibration that can 
only be used as input for the UAV operator 
Set Camera Calibration.  

 

 

Syntax 

DefineCameraCalibration (<FocalLength>, < Cx>, < Cy>,  
< Unit> , < PixelSizeX> [, PixelSizeY =<PixelSizeY>]) 
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Import Camera Calibration 

Category: GEOSYSTEMS UAV 

Default ports All available ports 

  

 

 

Description 

Allows the user to import an existing camera calibration from file for a number of different camera 
calibration formats. Additionally, the sensor pixel size must be provided (specified in millimeter).  

 

CalibrationFormat Parameter 

 

 

 

Value Description 

Agisoft Agisoft Camera Calibration (*.xml) 

Australis Australis Camera Parameters (*.txt) 

PhotoModeler PhotoModeler Camera Calibration (*.ini) 

Pix4D Pix4D Camera Calibration (*.cam) 

OpenCV OpenCV Camera Calibration (*.xml) 

Inpho Inpho Camera Calibration (*.txt) 
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Connections 

Name Objects Supported Description Required 

CalibrationType String/Enumeration The format of the CalibrationDataFile. 
 

CalibrationData
File 

File The file containing the camera calibration data 
in the format specified under 
CalibrationType. 

 

PixelSizeX Double The sensor pixel size in millimeter in x. If 
PixelSizeY is not provided, the specified 
value will be used for x and y.  

 

PixelSizeY Double The sensor pixel size in millimeter in y. If not 
provided, PixelSizeX will be used for y as 
well. 

 

UAVCalibration
Data 

UAVCalibrationData The created UAV camera calibration that can 
only be used as input for the UAV operator 
Set Camera Calibration.  

 

Set Camera Calibration 

Category: GEOSYSTEMS UAV 

Default ports All available ports 

 

 

 

 

Description 

With this operator the user can set/modify the camera calibration data for any of the existing cameras of 
the provided project. The cameras are selected by their names. Users can use the Dictionary Item 
operator to determine the desired camera name. UAVCalibrationData can be created using the operators 
Define Camera Calibration or Import Camera Calibration. With the port FixParameters the user can 
change the usage of the calibration data during the alignment process. For more details see the 
description of the possible parameter values.  
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FixParameters 
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Value Description 

None By selecting None, the provided camera 
calibration is only considered as pre-calibrated. 
The parameters will be modified during the 
alignment process.  

All By selecting All, Metashape will not modify any 
of the provided calibration parameters during 
alignment. This option allows the user to 
introduce already calibrated cameras. 

FocalLengthOnly By selecting FocalLengthOnly, Metashape will 
only exclude the focal length from being 
modified during the alignment process. All other 
calibration parameters will be modified. This is 
useful when the actual focal length is known but 
the camera itself is not calibrated. This will help 
the alignment process to derive more 
meaningful calibration parameters.   

Specify With the option Specify, a user can select very 
detailed which of the calibration parameter 
should be kept constant. The actual parameters 
are specified via FixedCalibrationParameter  

 

 

Connections 

Name Objects 
Supported 

Description Required 

UAVProjectName UAVProject An UAV Project that has been created 
using the Create Project Operator or 
loaded from disk using the Load Project 
Operator. 

 

CameraName String The name of the camera for which the 
calibration is set. The provided project 
must contain the camera under the same 
name. To set calibration data to several 
different cameras within a project, chain 
the Set Camera Calibration operator 
and select each camera individually by 
name. 

 

UAVCalibrationData UAVCalibrati
onData 

The sensor pixel size in millimeter in x. If 
PixelSizeY is not provided, the specified 
value will be used for x and y.  
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FixParameters String/Enum
eration 

The parameter specifying how the treat 
the camera calibration parameters during 
the alignment process. 

 

FixedCalibrationParameter String Optional port to select very detailed 
which calibration parameters to keep 
constant during the alignment process. 
Possible values are: F, Cx, Cy, B1, B2, 
K1, K2, K3, K4, P1, P2. Provide several 
values as comma separated list. The 
names of the parameter are case 
sensitive! The value of this port is only 
considered when 
FixParameters=Specify 

 

UAVProjectOut UAVProject The modified UAV project, which can 
now be used as input for the subsequent 
UAV operator Compute Orientation. 
After a successful execution, the file 
projectFile_initial.psx is re-created in the 
ImageDirectory. 

 

 

Syntax 

SetCameraCalibration (<UAVProjectName>, <CameraName>, <UAVCalibrationData>, 

<FixParameters> [, FixedCalibrationParameter=< FixedCalibrationParameter>]) 

 

Network Processing 

Category: GEOSYSTEMS UAV 

 

Default ports All available ports 

 
 

Description 

This optional operator enables the network processing for the model it is used in. Simply add the operator 
to the model, set the 3 port values and connect it to either Create Project or Load Project. All tasks of 
the model will be distributed of the configured cluster. It is important that the selected Input Folder of the 
Create Project operator or Project Name of the Load Project operator are located in a subfolder of the 
specified RootFolder. For a detailed description please see section 3. 
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or 

 

 

. 

 

Connections 

Name Objects 
Supported 

Description Required 

MasterServer String The configured master server of the 
processing cluster. The computer must be 
available in the same network from the 
local client and all processing nodes. 

 

MasterServerPort Integer The port on which the master server of the 
processing cluster is listening. The port on 
the remote server must be reachable from 
the local client and all processing nodes. 

 

RootFolder Directory  A base folder accessible from the client 
and all processing nodes. Raw input files 
and the created project files can be located 
in further subfolders. Important is write 
access of all processing nodes, at least for 
the actual project subfolder. 

 

NetworkConnection  NetworkConnectio
nData 

The network connection data to be used 
with Create Project and Load Project 
operator.   
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Syntax 

NetworkProcessing (<MasterServer>, <MasterServerPort>, < RootFolder>)  
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Marker Support 

Category: GEOSYSTEMS UAV 

 

Default ports All available ports 

 

 

Description 

This optional operator adds the possibility to use markers in order to introduce ground control information 
in your project. This information will be used to improve the overall positions of your images (e.g. if you do 
not use precise GPS-information). Please place the Marker Support Operator before the Compute 
Orientation operator. As a reference, consider the following example: 

 

In order to use this additional marker information within your project, you need to print and to place coded 
targets (CTs) on the ground before acquiring the images. Each CT has a ring parted in black and white 
segments around the central full circle that will be recognized by the program automatically. For each CT 
you need to define a geo-coordinate that will be used as reference coordinate within your image block. 
Thus, for every single CT the geo-position (X, Y, Z) must be acquired e.g. by classic surveying or high 
precision GNSS beforehand and listed in a text file. 

Later, in IMAGINE UAV, an orientation data format for the marker orientation file has to be created. It is 
the same dialog as used to define the file format for the orientation data file and thus, done in the same 
way. For more information, please refer to the Step-by-Step guide for the IMAGINE UAV Workflow starting 
on page 73. 

 



IMAGINE UAV - Manual Page 35/85 
 

  

© GEOSYSTEMS GmbH, 2021 

Connections 

Name Objects 
Supported 

Description Required 

UAVProjectName UAVProject An UAV Project that has been created 
using the Create Project Operator or 
loaded from disk using the Load Project 
Operator. 

 

MarkerFileFormat String/Enumeration Specifies the source/format to take marker 
data from. The list of supported marker file 
formats can be extended dynamically. 

 

MarkerDataFile String/Enumeration  Text file with marker data. The file format is 
specified by the MarkerFileFormat.  

MarkerTargetType  String/Enumeration Specifies the pattern used to identify the 
CTs. Here is one example of a CT: 

 

 

DetectorTolerance Double Specifies the tolerance used to detect the 
CTs in your images. Try to increase this 
value if the markers are not well detected. 

 

AccuracyXY Double Specifies the accuracy of the marker 
reference coordinates in X/Y in meters or in 
Latitude/Longitude in degrees.  

 

AccuracyZ Double Specifies the accuracy of the height 
component of the marker position in 
meters. 

 

 

Syntax 

MarkerSupport (<UAVProjectIn>, < MarkerFileFormat>, < MarkerDataFile>,  
< MarkerTargetType> [, DetectorTolerance=<DetectorTolerance>] [, 
AccuracyXY=<AccuracyXY>] [, AccuracyZ=<AccuracyZ>]) 
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Compute Orientation 

Category: GEOSYSTEMS UAV 

 

Default ports All available ports 

 

 

 

Description 

Computes the orientation of all images referenced in the UAVProjectIn. The computed orientation is an 
absolute orientation. The parameter Accuracy influences the quality of the computed orientation. A higher 
value results in a more precise determination of the camera positions, whereas a lower value produces a 
less precise result in a shorter period. The parameter Preselection determines how overlapping image 
pairs are found, which has a significant influence on the computation time, especially for large sets of 
image data. 

 

Accuracy Parameter 

 

 

 

Value Description 

Low Creates less precise camera positions but results are 
produced in a much shorter computation time. 

Medium Presents a balance between precise camera positions 
and computation time. 
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High Creates very precise camera positions but takes longer 
time for computation. If nothing is selected, this value is 
default. 

 

Preselection Parameter 

 

 

Value Description 

Disabled No preselection is executed. All possible image pair combinations 
are computed, resulting in a longer computation time. 

Generic The preselection is based on image correlation in lower resolution 
images. For large image datasets this can still consume a 
significant amount of time as all combinations of image pairs are 
being evaluated. 

Ground Control If ground control information (initial camera orientation data) were 
specified during project creation, this information is used to 
reduce the number of image pairs that are evaluated, thereby 
improving the computation time. 

 

Connections 

Name Objects Supported Description Required 

UAVProjectIn UAVProject An UAV Project that has been created using 
the Create Project Operator or loaded 
from disk using the Load Project Operator. 

 

Accuracy String/Enumeration Parameter influencing the accuracy of the 
computed orientation. Must be one of the 
values from the corresponding table above. 
If not provided, the default value high is 
used. 

 



IMAGINE UAV - Manual Page 38/85 
 

 

  
 

© GEOSYSTEMS GmbH, 2022 

Preselection String/Enumeration Parameter determining how overlapping 
image pairs are selected. Must be one of 
the values from the corresponding table 
above. If not provided, the default value 
generic is used.  

 

optimizeCameras Boolean Toggles the usage of the initial camera 
position data for the estimation process of 
the internal and external camera orientation 
parameters. By default, this flag is active.  

 

KeyPointLimit Integer Specify a custom number of key points to 
be considered when computing the 
orientation. The default is 40000. Higher 
numbers of key points allow the processing 
of e.g. free-standing objects in terrestrial 
recording situations. 

 

TiePointLimit Integer Specify a custom number of tie points to be 
considered when computing the orientation. 
The default is 10000. Higher numbers of tie 
points allow the processing of e.g. free-
standing objects in terrestrial recording 
situations. 

 

UAVProjectOut UAVProject The UAV project, which can only be used 
as input for the subsequent UAV operator 
Compute Surface. After a successful 
execution, the file projectFile_ori.psx is 
created in the ImageDirectory. 

 

Syntax 

ComputeOrientation ( <UAVProjectIn> [, Accuracy=<Accuracy> ][, 

Preselection=<Preselection>][, optimizeCameras=<optimizeCameras>][, 

KeyPointLimit=<KeyPointLimit>])[, TiePointLimit=<TiePointLimit>])) 
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Set Processing Region 

Category: GEOSYSTEMS UAV 

 

Default ports All available ports 

 

 

Description 

This optional operator allows to change the used processing region. By default, Agisoft Metashape 
computes a bounding region after the computation of the orientation has finished. With this operator the 
user can change the region freely. The operator can be used for two different purposes. 

1. To restrict the area considered for the computation of the actual surface and all subsequent 
operations (any export). 
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2. To export certain / several areas of the full dataset. 

 

 

A region is defined by a center point (SceneCenterX, SceneCenterY, SceneCenterZ), a size vector 
(SceneSizeX, SceneSizeY, SceneSizeZ) and three rotation angles around the axes (Omega, Phi, 
Kappa). The coordinate system, the center point coordinates are referring to, is specified on the port 
EPSG. The EPSG code does not have to match the EPSG code of the project or the orientation data. 

The size vector defines the dimension of the region in all three axis of the used coordinate system in the 
according units. (e.g. when using a UTM coordinate system, unit of the size vector values is meters, when 
using geographic coordinates, unit of the size vector values is degrees). Optionally, three rotation angles 
around the axes can be specified. By default, no rotation is applied (angles = 0).  

 

Region = (SceneCenter ± Size * 0.5) * RotationMatrix(Omega,Phi,Kappa) 

 

Depending on the use case 1) or 2), the parameter optimizeCameras should be set to true (default) or 
false. Setting the parameter to true will invalidate any computed surface and exports of any kind cannot be 
executed. Therefore, the parameter must be set to false when using the operator in use case 2). 

To extract the currently used region of a project, the Dictionary Item operator can be used. It allows to 
access several parameters of the project, including the scene center, scene size and rotation values. The 
following example reads the automatically computed region, reduces the size in x and y to 60% and sets 
that new region before computing the surface. 
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Connections 

Name Objects 
Supported 

Description Required 

UAVProjectName UAVProject An UAV Project that has been processed 
by Compute Orientation Operator or 
Compute Surface Operator. Any other 
location in the processing chain is not 
supported. 

 

SceneCenterX/Y/Z Double The coordinates of the scene center of the 
region to be defined. Coordinates refer to 
the coordinate system defined by EPSG. 

 

SceneSizeX/Y/Z Double  The dimension of the region to be defined. 
The units of the specified values are 
defined by the coordinate system defined 
by EPSG. 

 

EPSG  Integer The EPSG code the scene center 
coordinates refer to and the size values are 
specified in. The EPSG code doesn’t have 
to match the EPSG code of the project or 
the orientation data. 
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Omega/Phi/Kappa Double Specifies the tolerance used to detect the 
CTs in your images. Try to increase this 
value if the markers are not well detected. 

 

UAVProjectOut UAVProject The UAV project, which can only be used 
as input for the subsequent UAV operator 
Compute Surface or any of the export 
operators.  

UAVProjec
tOut 

 

Syntax 

SetProcessingRegion (<UAVProjectIn> , <SceneCenterX>, <SceneCenterY>,, 

<SceneCenterY>, <SceneSizeX>, <SceneSizeY>, <SceneCenterZ>,<EPSG>[, 

optimizeCameras=<optimizeCameras>] [, Omega=<Omega>] [, Phi=<Phi>][, 

Kappa=<Kappa>]) 

 

Compute Surface 

Category: GEOSYSTEMS UAV 

Default ports All available ports 

  

 

 

Description 

Computes the actual point cloud and surface based on the orientation, which has been set up by the 
Compute Orientation Operator. There are several parameters influencing quality and computation time. 
The parameter Quality influences the level of detail of the reconstruction. A higher value results in a more 
detailed reconstruction but can take a very long time to produce results. A lower value produces a coarser 
reconstruction but computation time is much shorter. The parameter Filter determines how the point cloud 
is being filtered. The point cloud can be filtered either aggressively, to yield a smooth surface or not at all, 
to keep all computed points. Use the parameter Mode to select the type of surface to be computed. In 
most cases this parameter can remain at default value. The parameter FaceCount determines how many 
polygons are used when meshing the computed point cloud. 
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Quality Parameter 

 

 

Value Description 

Lowest, Low, Medium Creates less detailed point clouds and 
computation time is relatively short. Should be 
used only to get a quick impression of the 
surface. 

High Creates a detailed reconstruction of the 
surface. Unless changed this value is default. 

Ultra Creates a very detailed reconstruction of the 
surface but increases the chance of outliers. 
Additionally, the computation time is 
significantly longer than using high. 

 

Filter Parameter 

 

 

Value Description 

Mild, Moderate Filters the point cloud to remove outliers but keeps 
detailed features. 
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Aggressive Filters the point cloud aggressively to yield a smoother 
surface, removing possible outliers and very small 
features. If nothing gets selected, this value is default. 

Disabled Does not filter the point cloud at all; thus keeps all 
computed points. 

Mode Parameter 

 

 

Value Description 

Arbitrary Can be used to model any type of surface. Typically, 
this value only has to be selected, if objects like 
buildings or statues are being reconstructed. 

Height Field Used to model planar surfaces and is suitable for most 
of the UAV workflows. If nothing is selected, this value is 
default. 

 

Face Count Parameter 
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Value Description 

Low Creates a smaller number of polygons or faces but 
computation time is shorter. 

Medium Presents a balance between low and high. If nothing is 
selected, this value is default. 

High Creates a large number of polygons or faces to mesh the 
point cloud but takes longer for computation. 

 

Source Data Parameter 

 

 

Value Description 

dense 
cloud 

Uses the computed dense cloud as the source for the 
model building, this value is the default and should be used 
in most cases. 

depth 
maps 

Use the computed depth maps instead.  

tie point 
cloud 

Use the computed point cloud of the tie point instead. 

 

Connections 

Name Objects Supported Description Required 

UAVProject UAVProject An UAV Project that has been created using the 
Compute Orientation Operator or loaded from 
disk using the Load Project Operator. 
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Quality String/Enumeration Parameter influencing the quality or details of the 
reconstruction of the surface. Must be one of the 
values from the corresponding table above. If not 
provided, the default value high is used. 

 

Filter String/Enumeration Parameter determining how to filter the computed 
point cloud to remove possible outliers and to 
create a smooth surface. Must be one of the 
values from the corresponding table above. If not 
provided, the default value aggressive is used.  

 

Mode String/Enumeration Parameter selecting the type of surface to 
reconstruct. Must be one of the values from the 
corresponding table above. If not provided, the 
default value height field is used.  

 

FaceCount String/Enumeration Parameter determining the number of 
polygons/faces to be used when meshing the 
surface. Must be one of the values from the 
corresponding table above. If not provided, the 
default value medium is used.  

 

SourceData String/Enumeration Parameter determining the source data for the 

model (triangulated irregular network,TIN) If 
not provided, the default value dense cloud is 
used. 

 

UAVProjectOut UAVProject The UAV project that can only be used as input for 
the subsequent export operators Export Mosaic 
Operator, Export LAS Operator and Export DEM 
Operator. After a successful execution, the file 
projectFile.psx is created in the ImageDirectory. 

 

 

Syntax 

ComputeSurface ( <UAVProjectIn> [, Quality=<Quality> ][, Filter=<Filter>] 

[, Mode=<Mode> ] [, FaceCount=<FaceCount> ] [, SourceData=<SourceData> ]) 

 
 

 

Export LAS 

Category: GEOSYSTEMS UAV 
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Description 

Exports the computed point cloud as LAS file with RGB encoding. If the point cloud was reconstructed 
from image data with known camera positions and the parameter EPSG is provided, the LAS point cloud 
is re-projected to the specified coordinate system. Otherwise local planar coordinates are used. 

See HexGeoWiki EPSG Coordinate Systems 
(https://wiki.hexagongeospatial.com//index.php?title=EPSG_Coordinate_Systems). 

Connections 

Name Objects 
Supported 

Description Required 

UAVProject UAVProject An UAV Project that has been created using the Compute 
Surface Operator or loaded from disk using the Load Project 
Operator. 

 

LASName File File name of the LAS file to be created. 
 

EPSG Integer If the point cloud was reconstructed from image data with known 
camera positions, use this parameter to assign the projection 
and to re-project the result into the desired coordinate system. 
Set value to 0 to skip exporting with projection information. 

 

LASFile File Created LAS file on disk.  

 

Syntax 

ExportLAS ( <UAVProject> , <LASName> [, EPSG=<EPSG>] ) 

 

Export PointCloud 

Category: GEOSYSTEMS UAV 

  

Description 

Exports the computed point cloud to several point cloud formats such as Wavefront OBJ format, 
Stanfort PLY format, XYZ point cloud format, ASPRS LAS file, LAZ format, U3D format, Adobe PDF 
format, ASTM E57 format, Agisoft OC3 format, Potree format,Topcon CL3 format, Cesium 3D tiles 
format, ASCII PTS format, Autodesk DXF format. If the point cloud was reconstructed from image data 
with known camera positions and the parameter EPSG is provided, the point cloud is re-projected to the 
specified coordinate system. Otherwise local planar coordinates are used. 

See HexGeoWiki EPSG Coordinate Systems 
(https://wiki.hexagongeospatial.com//index.php?title=EPSG_Coordinate_Systems). 

https://wiki.hexagongeospatial.com/index.php?title=EPSG_Coordinate_Systems
https://wiki.hexagongeospatial.com/index.php?title=EPSG_Coordinate_Systems
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Export Format Parameter 

 

 

 

Connections 

Name Objects Supported Description Required 

UAVProject UAVProject An UAV Project that has been created using the 
Compute Surface Operator or loaded from disk 
using the Load Project Operator. 

 

PointCloudName File File name of the point cloud file to be created. 
 

    

Format String/Enumeration The selected format to export the point cloud to. 
 

EPSG Integer If the point cloud was reconstructed from image data 
with known camera positions, use this parameter to 
assign the projection and to re-project the result into 
the desired coordinate system. Set value to 0 to skip 
exporting with projection information. 

 

PointCloudFile File Created LAS file on disk.  

 

Syntax 

ExportPointCloud ( <UAVProject> , <PointCloudName>, <Format> , <EPSG>) 
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Export DEM 

Category: GEOSYSTEMS UAV 

 

 

Default ports All available ports 

 

 

 

Description 

Exports the computed surface as digital elevation model. The export supports the image file formats 
JPEG2000 and TIF. When exporting to JPEG2000, the bit depth of the data is converted to unsigned 8 
bit. Exporting to TIF keeps the original bit depth of 32, producing float data type. For TIF images, pyramid 
files are computed automatically. If the surface was reconstructed from image data with known camera 
positions and the parameter EPSG is provided, the DEM file is re-projected to the specified coordinate 
system. Otherwise local planar coordinates are used. Using the BigTIFFCreation parameter allows you to 
determine whether TIFF files should be written as BigTIFF or not. When a ContourName is provided, the 
contour lines are computed and saved to the specified file, considering the computation options. By 
default, the ground sampling distance (spatial resolution) of the original data is used for the export. Select 
Specify as the ResolutionType to enter a custom resolution for the export.  

 

See HexGeoWiki EPSG Coordinate Systems 
(https://wiki.hexagongeospatial.com//index.php?title=EPSG_Coordinate_Systems). 

https://wiki.hexagongeospatial.com/index.php?title=EPSG_Coordinate_Systems
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BigTIFF Creation Parameter 

 

 

Value Description 

auto IMAGINE UAV determines based on the image dimension 
if it is necessary to use BigTIFF. 

no Created TIFF files are never written as BigTIFF. 

yes Created TIFF files are always written as BigTIFF. 

 

ContourType Parameter 

 

 

Value Description 

Polyline The contour lines will be saved as Polyines.  

Polygon The contour lines will be saved as Polygon. 

 

Resolution Type Parameter 
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Connections 

Name Objects 
Supported 

Description Required 

UAVProject UAVProject An UAV Project that has been created using 
the Compute Surface Operator or loaded 
from disk using the Load Project Operator. 

 

DEMName File File name of the DEM file to be created. 
Supports the export of the formats TIF and 
JPEG2000. 

 

EPSG Integer If the surface was reconstructed from image 
data with known camera positions, use this 
parameter to assign the projection and to re-
project the result into the desired coordinate 
system. Set value to 0 to skip exporting with 
projection information. 

 

ResolutionType String/Enumeration Specify how to determine the spatial 
resolution (ground sampling distance) for the 
exported DEM. Selecting Original will use 
the ground sampling distance automatically 
derived from the input data. When selecting 
Specify, enter a custom resolution on port 
Resolution. Default is Original 

 

Resolution Double Enter the custom resolution for the DEM 
export. Only considered when 
ResolutionType Specify has been 
selected. The unit of the entered resolution 
is always meters, regardless of the used 
projection. 

 

BigTIFFCreation String/Enumeration Specify how to handle TIFF format export.  

ContourName File File name of the contour line file to be 
created. Only Shape format is supported. 
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ContourShapeType String/Enumeration Specifies the type of vector feature to us 
when exporting the contour lines. Default is 
‘Polyline’ 

 

ContourInterval Double Specifies the distance between to contour 
lines in unit of DSM (typically meters). 
Default values is 1. 

 

MinContourRange Double Specifies the lower range of contour lines to 
include. Lines with a smaller height value will 
be excluded. If not provided no lower range 
is applied. 

 

MaxContourRange Double Specifies the upper range of contour lines to 
include. Lines with a higher height value will 
be excluded. If not provided no upper range 
is applied. 

 

SaveProject Bool With this flag set to True, the DEM data will 
be stored in the project file as well. When set 
to False, only the exported DEM file is being 
stored. The default is True. 

 

DEMFile File Created DEM file on disk.  

 

Syntax 

ExportDEM ( <UAVProject> , <DEMName> , <EPSG> ,<ResolutionType> [, 

BigTIFFCreation=< BigTIFFCreation>][, ContourName=<ContourName>][, 
ContourShapeType=< ContourShapeType>][, ContourInterval=< 
ContourInterval>][, MinContourRange=< MinContourRange>][, MaxContourRange=< 
MaxContourRange>][,SaveProject=<SaveProject>][, Resolution=<Resolution>]) 

 
 

Export Mosaic 

Category: GEOSYSTEMS UAV 

Default ports All available ports 
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Description 

Exports the computed surface as digital ortho mosaic. The export supports the image file formats ECW, 
JPEG2000, IMG and TIF. When exporting to ECW only the 3 RGB bands are kept. Exporting to TIF and 
JPEG2000 also preserves the mask band. For TIF images, pyramid files are computed automatically. If 
the surface was reconstructed from image data with known camera positions and the parameter EPSG is 
provided, the mosaic file is re-projected to the specified coordinate system. Otherwise, local planar 
coordinates are used. By default, the ground sampling distance (spatial resolution) of the original data is 
used for the export. Select Specify as the ResolutionType to enter a custom resolution for the export.  

See HexGeoWiki EPSG Coordinate Systems 
(https://wiki.hexagongeospatial.com//index.php?title=EPSG_Coordinate_Systems). 

BigTIFF Creation Parameter 

 

TIFF Compression Parameter 

 

 

 

Resolution Type Parameter 

 

 

https://wiki.hexagongeospatial.com/index.php?title=EPSG_Coordinate_Systems
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Connections 

Name Objects Supported Description Required 

UAVProject UAVProject An UAV Project that has been created using the 
Compute Surface Operator or loaded from disk 
using the Load Project Operator. 

 

MosaicName File File name of the mosaic file to be created. 
Supports the export of the formats ECW, TIF, 
IMG and JPEG2000. 

 

EPSG Integer If the surface was reconstructed from image data 
with known camera positions, use this parameter 
to assign the projection and to re-project the 
result into the desired coordinate system. Set 
value to 0 to skip exporting with projection 
information. 

 

ResolutionType String/Enumeration Specify how to determine the spatial resolution 
(ground sampling distance) for the exported 
mosaic. Selecting Original will use the ground 
sampling distance automatically derived from the 
input data. When selecting Specify, enter a 
custom resolution on port Resolution. Default is 
Original 

 

Resolution Double Enter the custom resolution for the mosaic 
export. Only considered when ResolutionType 
Specify has been selected. The unit of the 
entered resolution is always meters, regardless of 
the used projection. 

 

BigTIFFCreation String/Enumeration Specify how to handle TIFF format export.  

TIFFCompression String/Enumeration Specify the compression method used when 
exporting to TIFF. 

 

SaveProject Bool With this flag set to True, the mosaic data will be 
stored in the project file as well. When set to 
False, only the exported mosaic file is being 
stored. The default is True. 

 

MosaicFile File Created ortho mosaic file on disk.  

 

Syntax 

ExportMosaic ( <UAVProject> , <MosaicName> ,<EPSG> ,<ResolutionType> [, 

BigTIFFCreation=<  >][, TIFFCompression=<TIFFCompression>] 
[,SaveProject=<SaveProject>][, Resolution=<Resolution>]) 
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Export Model 

Category: GEOSYSTEMS UAV 

Default ports All available ports 

 

 

Description 

Exports the generated model data to disk. The export supports the formats Wavefront OBJ, 3DS model, 
VRML model, COLLADA, Stanfort PLY, STL model, Alembic, Autodesk FBX, Autodesk DXF 
Polyline, Autodesk DXF 3DFace, U3D model, Adobe PDF, Binary glTF, X3D and Google Earth KMZ. 
If the surface was reconstructed from image data with known camera positions and the parameter EPSG 
is provided, the model file is re-projected to the specified coordinate system. Otherwise local planar 
coordinates are used. 

See HexGeoWiki EPSG Coordinate Systems 
(https://wiki.hexagongeospatial.com//index.php?title=EPSG_Coordinate_Systems). 

Model Format Parameter 

 

 

  

https://wiki.hexagongeospatial.com/index.php?title=EPSG_Coordinate_Systems
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Mapping Strategy Parameter 

 

 

Texture raster Format 

 

 

 

Connections 

Name Objects Supported Description Required 

UAVProject UAVProject An UAV Project that has been created using the 
Compute Surface Operator or loaded from disk 
using the Load Project Operator. 

 

ModelName File File name of the model file to be created. See 
supported formats below.  

EPSG Integer If the surface was reconstructed from image data 
with known camera positions, use this parameter 
to assign the projection and to re-project the 
result into the desired coordinate system. Set 
value to 0 to skip exporting with projection 
information. 
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ModelFormat String/Enumeration a. Specify the format to use when exporting 
the model data. Supports the export of 
the formats Wavefront OBJ, 3DS model, 
VRML model, COLLADA, Stanfort PLY, 
STL model, Alembic, Autodesk FBX, 
Autodesk DXF Polyline, Autodesk DXF 
3DFace, U3D model, Adobe PDF, 
Google Earth KMZ, Binary glTF model 
format, X3D model format. Important: 
Binary glTF and X3D are only 
supported with Agisoft Metashape 
1.5.x 

. 

 

exportTexture Boolean Use this option to additionally export created 
texture. 

 

TextureFormat String/Enumeration Select the format of the texture export.  

SaveProject Bool With this flag set to True, the model data will be 
stored in the project file as well. When set to 
False, only the exported model file is being 
stored. The default is True. 

 

ModelFile File Created model file on disk.  

 

Syntax 

ExportModel ( <UAVProject> , <ModelName> ,<EPSG>, <ModelFormat>, [, 

MappingStrategy=<MappingStrategy>][, exportTexture=<exportTexture>] [, 
TextureFormat=<TextureFormat>][,SaveProject=<SaveProject>]) 
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Export TiledModel 

Category: GEOSYSTEMS UAV 

Default ports All available ports 

 

 

Description 

Exports the generated model data as tiled model to disk. The export supports the formats Wavefront 
OBJ, 3DS model, VRML model, COLLADA, Stanfort PLY, STL model, Alembic, Autodesk FBX, 
Autodesk DXF Polyline, Autodesk DXF 3DFace, U3D model, Adobe PDF and Google Earth KMZ. 
The parameter ModelFormat is used to select the mesh format when exporting to a ZIP based tiled 
model. 

See HexGeoWiki EPSG Coordinate Systems 
(https://wiki.hexagongeospatial.com//index.php?title=EPSG_Coordinate_Systems). 

TiledModel Format Parameter 

 

 

https://wiki.hexagongeospatial.com/index.php?title=EPSG_Coordinate_Systems
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Data Source Parameter 

 

 

Mesh model for ZIP export Parameter 

 

 

 

Face count Parameter 
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Connections 

Name Objects Supported Description Required 

UAVProject UAVProject An UAV Project that has been created using the 
Compute Surface Operator or loaded from disk 
using the Load Project Operator. 

 

TiledModelName File File name of the tiled model file to be created. 
See supported formats below.  

TiledModelFormat String/Enumeration Specify the format to use when exporting the 
model data. Supports the export of the formats 
Cesium 3D Tiles, Scene Layer Package, 
PhotoMesh Layer, Agisoft Tiled Model, 
Agisoft Tile Archive. 

 

DataSource String/Enumeration Select which data to use for the export. Possible 
data sources are PointCloud and Mesh.  

MeshFormat String/Enumeration Specify the format of the mesh data when 
exporting ZIP based tiled models. Supports the 
formats Wavefront OBJ, 3DS model, VRML 
model, COLLADA, Stanfort PLY, STL model, 
Alembic, Autodesk FBX, Autodesk DXF 
Polyline, Autodesk DXF 3DFace, U3D model, 
Adobe PDF, Google Earth KMZ. 

 

PixelSize Double Target model resolution in meters. If not 
provided, target resolution is determined 
automatically. 

 

TileSize Integer Size of tiles in pixels. Default: 256  

FaceCount String/Enumeration Parameter determining the number of 
polygons/faces to be used when creating the 
output mesh. Must be one of the values from the 
corresponding table above. If not provided, the 
default value medium is used.  

 

SaveProject Bool With this flag set to True, the tiled model data will 
be stored in the project file as well. When set to 
False, only the exported tiled model file is being 
stored. The default is True. 

 

TiledModelFile File Created tiled model file on disk.  

Syntax 

ExportTiledModel ( <UAVProject> , <TiledModelName> ,<TiledModelFormat>, 

<DataSource>,  [, MeshFormat =<MeshFormat>][, PixelSize=<PixelSize>] 
[,TileSize=<TileSize>][,FaceCount=<FaceCount>][,SaveProject=<SaveProject>]) 
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Export Project 

Category: GEOSYSTEMS UAV 

Default ports All available ports 

 

 

Description 

Exports the generated model data to another project format. The export supports the formats Agisoft 
XML, CHAN files, Boujou, Bundler, Omega Phi Kappa, PATB project, BINGO project, ORIMA, 
AeroSys exterior orientation, Inpho project file, Summit evolution project, Blocks Exchange, 
Realviz RZML, VisionMap, Alembic and Autodesk FBX. If the surface was reconstructed from image 
data with known camera positions and the parameter EPSG is provided, the project is re-projected to the 
specified coordinate system. Otherwise local planar coordinates are used.  

See HexGeoWiki EPSG Coordinate Systems 
(https://wiki.hexagongeospatial.com//index.php?title=EPSG_Coordinate_Systems). 

Project Export Format Parameter 

 

 

https://wiki.hexagongeospatial.com/index.php?title=EPSG_Coordinate_Systems
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Rotation Order Parameter 
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Connections 

Name Objects Supported Description Required 

UAVProject UAVProject An UAV Project that has been created using the 
Compute Surface Operator or loaded from disk 
using the Load Project Operator. 

 

ProjectName File File name of the project file to be created. See 
supported formats below.  

EPSG Integer If the surface was reconstructed from image data 
with known camera positions, use this parameter 
to assign the projection and to re-project the 
result into the desired coordinate system. Set 
value to 0 to skip exporting with projection 
information. 

 

Format String/Enumeration Specify the format of the project export. Supports 
the formats Agisoft XML, CHAN files, Boujou, 
Bundler, Omega Phi Kappa, PATB project, 
BINGO project, ORIMA, AeroSys exterior 
orientation, Inpho project file, Summit 
evolution project, Blocks Exchange, Realviz 
RZML, VisionMap, Alembic, Autodesk FBX. 

 

includeTiePoints Boolean Select this option to include tie points in the 
exported project. 

 

includeMarkers Boolean Select this option to include markers in the 
exported project. 

 

RotationOrder String/Enumeration Specify the rotation order to use when exporting 
the project data. Supported orders are XYZ, XZY, 
YXZ, YZX, ZXY, ZYX. 

 

ProjectFile File Created tiled model file on disk.  

Syntax 

ExportProject ( <UAVProject> , <ProjectName> ,<EPSG>, <Format>,  [, 

includeTiePoints=<includeTiePoints>][, includeMarkers=<includeMarkers>] 
[,RotationOrder=<RotationOrder>]) 

 

 

Export Report 

Category: GEOSYSTEMS UAV 

 

Default ports All available ports 
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Description 

Exports the triangulation report of an existing UAVProject. The report will be written as PDF. If provided a 
customized Title and Description can be added to the report. 

 

Connections 

Name Objects 
Supported 

Description Required 

UAVProject UAVProject An UAV Project that has been created using 
the Compute Orientation or Compute 
Surface Operator or loaded from disk using 
the Load Project Operator. 

 

ReportName File File name of the Report file to be created. The 
report will be written as PDF.  

Title String Custom title used in the created report.  

Description String Custom description used in the created report  

ReportFile File Created Report file on disk.  

 

Syntax 

ExportReport ( <UAVProject> , <ReportName> [, Title=<Title>] 

[,Description=<Description>]) 

Export Blockfile 

Category: GEOSYSTEMS UAV 

Default ports All available ports 
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Description 

Exports a triangulated project (UAV Project that has been created using the Compute Orientation 
Operator or Compute Surface Operator) as blockfile *.blk for further usage in IMAGINE 
Photogrammetry. (e.g. stereointerpretation or single ortho file generation). There are two options to use 
the blockfile export operator. Either (1), load a projectFILE_ori.psx or projectFILE.psx and connect it to the 
Export Block File operator, or (2) set up a project with the CreateProject operator, connect it to the 
Compute Orientation operator and finally export the orientation via the Export Block File operator. Set the 
EPSG code to reproject the exported camera position information.  

(1) 

 

(2) 

 

See HexGeoWiki EPSG Coordinate Systems 
(https://wiki.hexagongeospatial.com//index.php?title=EPSG_Coordinate_Systems). 

Tie point filter type parameter 

 

https://wiki.hexagongeospatial.com/index.php?title=EPSG_Coordinate_Systems
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Connections 

Name Objects 
Supported 

Description Required 

UAVProjectIn UAVProject An UAV Project that has been created using the 
Compute Orientation Operator or Compute 
Surface Operator or loaded from disk using the 
Load Project Operator. 

 

BlockFileName File File name of the BLK file to be created. Supports 
the export to the BLK format.  

EPSG Integer Output projection for the created BLK file. Use a 
valid projected coordinate system EPSG code. 
Camera position information will be reprojected. 

 

DEMFileName File Optionally provide a DEM/DSM covering the 
project area. That file will be added to the BLK file. 
It is advisable to use only DEM/DSMs, which 
contain information about the elevation reference 
to avoid misalignments. For best results, use 
directly the output created by the Export DEM 
operator. 

 

logData Bool Flag to enables additional logging to the session 
log. 

 

includeTiePoints Bool Flag to enable the export of the tie points used for 
the triangulation. 

 

filterTiePoints Bool Flag to enable the filtering of the tie points used 
for the triangulation. By default, no filtering is 
applied.  

 

TiePointFilterType String/Enumer
ation 

Specifies the type of filtering to apply to the tie 
points during export. Supported types are 
ReprojectionError, ReconstructionUncertainty, 
ImageCount, ProjectionAccuracy. 

 

TiePointFilterValue Double The actual value used to filter the tie points. 
Depending on the selected TiePointFilterType, tie 
points above that value (ImageCount, 
ProjectionAccuracy) or below 
(ReprojectionError, 
ReconstructionUncertainty) are being exported. 

 

BlockFile File Created BLK file on disk.  

 

Syntax 

ExportBlockFile ( <UAVProjectIn> , <BlockFileName> , <EPSG> [, 
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DEMFileName=<DEMFileName>, logData=<logData>, 

includeTiePoints=<includeTiePoints>, filterTiePoints=<filterTiePoints>, 

TiePointFilterType=<TiePointFilterType>, 

TiePointFilterValue=<TiePointFilterValue>]  
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Section 3 

Network processing 

Agisoft Metashape supports the computation of projects across several computers in a local network, 
joined in processing cluster. Such distributed processing reduces the processing time of large projects 
significantly. To utilize this functionality, a cluster of processing nodes must be configured. 

IMAGINE UAV acts only as a client node in this cluster scenario. The setup and configuration of the actual 
cluster is not part of IMAGINE UAV. The brief steps described in this document are only meant for a quick 
start. For more details please refer to the Agisoft Metashape help.  

On all components Agisoft Metashape must be installed and licensed. IMAGINE UAV is only required on 
the client, starting the processing. 

A processing cluster consist of four main components: 

1. Master server 
The master node is the central communication unit, handling the scheduling and distribution of 
individual processing tasks across the configured nodes. With its central role in the cluster, the 
master server is not fault tolerant. For more fault tolerant configurations, please see the Agisoft 
Metashape help. The master server listens on one dedicated port, which can be freely configured. 
The default is 5840. All processing nodes and clients must be allowed to connect to that port on 
the master server. The master server itself doesn’t act as a processing node itself and therefore 
doesn’t require to be on a strong machine.  

2. Processing node 
A processing node executes an assigned processing task and therefore has to run on fast 
hardware. A cluster can consist of any number of processing nodes. Nodes connect on start up to 
the cluster and wait for assigned tasks to be processed. Nodes can also be removed form a 
cluster at any time. Important to note is, that results are written to a shared network location. All 
nodes must have write privileges.  

3. Client 
A client node acts as the entry point of processing tasks into the cluster. A cluster can have 
several clients submitting new processing tasks into the cluster. IMAGINE UAV acts as such 
client. Using the IMAGINE UAV EML dialogs or directly the operators in a custom Spatial Model 
will define and submit for each UAV operator the necessary tasks and submit them to the cluster. 
The project creation or loading within IMAGINE UAV must be executed on the same network 
share, configured in the cluster. From IMAGINE UAVs perspective, executing the processing of a 
project locally or in a cluster is identical. IMAGINE UAV will wait for all operators to complete.  

4. Network storage 
The network storage is the central place client and nodes must have write access to. It is 
recommended to use UNC path notation. 
 

Communication between master server, processing nodes and clients is done via TCP/IP. Please note, 
that it is possible to add the master server, as well as any client, as a processing node to the cluster. This 
will consume only one Agisoft Metashape license one each computer. 
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The extra tool Agisoft Network Monitor allows the monitoring of the components of a cluster. It can be 
installed on any machine having access to the master server in the network (including the master server 
itself). 

 



IMAGINE UAV - Manual Page 70/85 
 

 

  
 

© GEOSYSTEMS GmbH, 2022 

Configuration of cluster 

The configuration of the cluster is not part of IMAGINE UAV. The steps described below are only a brief 
introduction. For more details, please see the Agisoft Metahshape help. 

On all components of the cluster Agisoft Metashape must be installed and licensed. The start of a master 
server or processing node uses the Metashape executable. 

Configuration of master server 

metashape --server --host <IP of master server>[:<port on master server>] 

e.g.: metashape --server --host 10.0.0.107:5840 

A master server can also be configured as Windows service. 

metashape --service install --server --host <IP of master server>[:<port on master server>] 

There are several other parameters for a more fine-grained configuration available in the Agisoft 
Metashape help. 

Configuration of processing node 

metashape --node --host <IP of master server>[:<port on master server>] --root <Root folder on network 
share> 

e.g. metashape --node --host 10.0.0.107:5840 --root \\fangorn\E\Data 

A master server can also be configured as Windows service. 

metashape --service install --node --host <IP of master server>[:<port on master server>] 

 --root <Root folder on network share> 

There are several other parameters for a more fine-grained configuration available in the Agisoft 
Metashape help.  

If configured as service, make sure that the windows account used as service user has access to the 
network share specified under --root. 

Project setup in IMAGINE UAV 

There is no need to configure Metashape manually in the interface, simply start either the master server or 
any node as described above. 

Also, on the machine IMAGINE UAV is running on, no configuration directly in Agisoft Metashape is 
necessary. All configuration needed is the usage of the Network Processing Operator in your Spatial 
Model or the selection and specification of the Network processing options in the EML dialog. 

 

Step by Step 

1. Configure the master server as described above and start. You can now connect to the server 
using the Agisoft Network Monitor.  
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2. Configure all nodes as described above and start. They should become available in the Network 
Monitor. If not, please verify your firewall or proxy settings in the network. 
 
 

 
 
 

3. Create IMAGINE UAV project with Network Processing option and execute. 
a. Via EML dialogs 

 

 
 

b. Directly in custom Spatial Model 
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4. IMAGINE UAV will behave the same way as you are used to it when processing locally.  
a. The locally executed Spatial Model process will be shown with it progress in the IMAGINE 

Process List.  
b. Logging information will be written to the IMAGINE Session log. 
c. The Spatial Model process will be running until the project computation completes (gets 

cancelled or fails).  
5. While IMAGINE UAV is executed locally, for each UAV Operator in the Spatial Model it will create 

and submit the necessary tasks to the processing cluster. Each operator will wait until its 
submitted tasks have completed. 
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Section 4 

Step-by-Step guide for the IMAGINE UAV Workflow 

This guide leads you through all steps of the UAV workflow that you need to produce the results. The 
outcome consists of two raster datasets, the image mosaic, and the digital surface model, as well as a 
point cloud file stored in LAS format. This guide is based on UAV example data that is part of the installer. 
If you selected to install the example data, it is located in the folder: 
C:\Users\Public\GEOSYSTEMS\UAV\examples\gravel-pit. 

The UAV example datasets have been provided by GRID-IT (http://www.grid-it.at/). 

Notes regarding the input data: 

⚫ Use a digital camera with reasonably high resolution (5 Megapixel or more). 

⚫ Avoid ultra-wide angle and fish-eye lenses. The best choice is a lens with 50 mm focal length 
(35 mm film equivalent) but focal length might vary from 20 to 80 mm.  

⚫ Lenses with a fixed focal length are preferred. If you use a zoom lenses - focal length should be 
set either to maximal or minimal value. 

⚫ Try to use the RAW data lossless converted to TIFF files. JPG compression adds unwanted noise 
to the images which might affect the accuracy. 

⚫ The ISO-value should be set to the lowest possible value. High ISO values add additional noise to 
the images. 

⚫ Always use the original images. Do not crop or geometrically transform (for example, resize or 
rotate) the images. 

⚫ Rough rule for image overlap: 60% of side overlap + 80 % of forward overlap 

 

Examine the Input Data Processing Step 

The first processing step is to examine your input datasets to help you choose the right options for all 
processing settings as well as to get a rough idea about the processing time. 

Notable details: 

⚫ File format (for example, JPG or TIF) 

⚫ Number of input datasets 

⚫ Number of columns and rows of each input file 

⚫ Type of the used image orientation (EXIF, external file, no orientation) 

⚫ Coordinate reference system of your reference data (centre coordinates of the images) 

⚫ Geographic projection for your study area 
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The example dataset contains 15 jpg-images and one text file. 

 

1. Check the image properties by right-clicking on an image and selecting Properties > Details. The 
dimension of each image is 6000 by 4000 pixels. 
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2. Next, look for GPS coordinates of the image center in the EXIF-information block. The provided 
images of the UAV example dataset also lack this kind of information. Depending on the source, thus 
the camera, of your images, you may find a GPS section inside the image metadata. 

3. Compare the properties of the following two JPG images.  
The first one presents the properties of one of the example images that does not contain GPS 
information. 
However, the second one shows the details of an image that does contain GPS information. 

No GPS Information GPS information is present 

  

 

When dealing with images taken by a camera having a GPS sensor which collects position information of 
longitude, latitude and elevation, processing of this information is easy. The GPS information is directly 
used, if you select the option From EXIF in the setup project step. There is no need to reference any 
external files during data processing. You can skip the next block and can continue with ‘Start 
Processing’  

The following example describes the workflow if no EXIF information is provided. In this case you need to 
"import" the image position from an external text file, which is included in the example directory.  

Define Orientation Format Processing Step 

You can skip this step if you process datasets that have valid GPS information of X, Y and Z in the EXIF-
header. 

To use the orientation information stored in a text file, you need to define the input file structure. Have a 
look at the orientation file included in the example data.  
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1. You can load C:\Users\Public\GEOSYSTEMS\UAV\examples\gravel-

pit\image_positions.txt in any text editor. 

 

This plain text file contains comma separated values. The actual data values start from the second 
row. Please, focus on the image filename (column 2), as well as on the image center coordinates X, Y 
and Z (column 3, 4 and 5). Since the algorithm used during image orientation is very robust, the 
camera rotation angles (omega, phi, kappa) do not have to be considered for most of the cases. In 
order to project the results correctly, you need to know which coordinate reference system is used. In 
this case, Lat/Lon values are based on WGS84. Thus, the EPSG code of the underlying coordinate 
reference system is 4326. 

Based on all this information you can define the orientation format using the Edit orientation formats 
dialog. 

2. Click Toolbox tab > Imagine UAV > Edit orientation formats to open the Orientation data formats 
dialog. 
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3. Create a new format definition in the Orientation Format Editor by clicking the + button, next to the 
Available formats list. This adds a new entry to the format list. You can directly change the name or 
double click on the entry for renaming later. Now set the name to Gravelpit. 

 

4. Optionally you can load the actual file 
(C:\Users\Public\GEOSYSTEMS\UAV\examples\gravel-pit\image_positions.txt) with 

the orientation data to preview the effect of the newly created orientation format. To do so, click on 
Load text file for preview and select the text file. The window has two tabs, Preview shows the 
applied format and the other the original data of the text file. You can easily see which additional 
settings might be needed to read the text file successfully. 

5. Under Column definition, assign the column numbers to the required processing values and specify 
the coordinate reference system of the input values. The image filename is stored in column 2 of the 
input data. Find the image center coordinates X, Y and Z in columns 3, 4 and 5. Since you are not 
using rotation angles, keep this option disabled. The EPSG-code of the coordinate reference system 
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is 4326. Under Delimiter, ensure that Comma is used as column delimiter. For this example, the 
settings should look as follows: 

 

 

6. Under Advanced tab, skip the first line containing the column descriptions. Add a new ignore line 
entry by clicking the + button in the lines to ignore group. This adds a new skip entry starting from 1 
and ending with line 1. Entries can easily be modified. Select the ignore option and modify the start 
and end options. Alternatively, you may also set a comment character or characters. All lines starting 
with this character are skipped. You may add any number of skip options. 
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7. Click Save & Close to save all modified settings. 

The additional options allow you to: 

▪ Define a constant offset for all input values (for example, if coordinates have been cut off) 

▪ Define a scale factor for each input value (for example, if the input values are stored in cm but you 
need to use m for the process) 

▪ Overwrite the decimal delimiter (for example, certain countries are using "," as default decimal 
delimiter) 

▪ The tab Height reference allows you to specify the reference surface your height data are 
referring to. By default, it is assumed that ellipsoidal height values are provided, according to the 
spheroid and datum used by the EPSG code (Reference surface of current EPSG code). If this 
is not the case, you can also manually specify the reference surface (Manually selected height 
reference surface). 

Now you are ready to start processing the UAV example dataset. 

Start Processing 

1. Open the run model dialog by clicking Toolbox tab > IMAGINE UAV > Run UAV process. 

 

2. Specify the following processing options in the dialog: 

⚫ Input Folder: C:/users/public/geosystems/uav/examples/gravel-pit/ 

⚫ File Selection Filter: *.jpg (all jpg files in the Input Folder are selected) 

⚫ Orientation Format: Gravelpit (created in Define Orientation step) 

⚫ Orientation File Input: C:/users/public/geosystems/uav/examples/gravel-pit/ 

image_positions.txt  

⚫ Surface Quality: high (very detailed point cloud and thus surface; takes much more time to compute 
compared to medium; select low for a first try when dealing with an unknown dataset in order to reduce 
the computation time to a minimum) 

⚫ Set the output projection to 32632 (UTM zone 32 north/WGS84) 

⚫ Set the output file for the point cloud in LAS-format: gravelpit_pc.las (in any directory with write 

access – for example, create a new directory 
C:/users/public/geosystems/uav/examples/gravel-pit/results)Set output file 

for the DSM in TIF-format: gravelpit_dsm.tif (in any directory with write access – for example, 

create a new directory C:/users/public/geosystems/uav/examples/gravel-

pit/results) 
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⚫ Set output file for the mosaic in TIF-format: gravelpit_mosaic.tif (in any directory with write 

access – for example, create a new directory 
C:/users/public/geosystems/uav/examples/gravel-pit/results) 

The settings should look as follows. Double check before you proceed.  
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3. Click Run. Depending on the power or speed of your PC, the processing can take 20 - 30 minutes to 
finish. Check the process status in the ERDAS IMAGINE Process List. Each operator reports the 
current progress. 

 

 

Display the Results Processing Step 

After the process has finished, you can display the three output datasets in the View.  

1. Open the mosaic or DSM as raster files in the View. 

 

 

2. You can open the computed point cloud (LAS format) in the View by clicking File > Open Point 
Cloud Layer. As shown, the points are RGB-encoded, meaning that every point has stored the RGB-
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value of the underlying input pixel. You are also able to display the point cloud in 3D (Point Cloud > 
Group “3D View” > Show 3D). 

 

 

 

Using the UAV Operators  

If you have access to an ERDAS IMAGINE Professional license, you can use the UAV operators within 
the Spatial Modeler. 

We are providing a pre-made UAV model that you can open by clicking View model in the UAV main 
menu. This loads the base model within the Spatial Modeler Editor. 

In order to process the example dataset, change the following settings: 

⚫ Input ports of the Create project operator: 

▪ Image Directory: C:/users/public/geosystems/uav/examples/gravel-pit/ 

▪ Orientation Format: Gravelpit 
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▪ Orientation File: C:/users/public/geosystems/uav/examples/gravel-pit/image-
positions.txt 

⚫ Input ports of the Export LAS operator: 

▪ LASName: output file for the point cloud in LAS-format: gravelpit_pc.las 

▪ EPSG: 32632 (UTM zone 32 north/WGS84) 

⚫ Input ports of the Export Mosaic operator: 

▪ MosaicName: output file for the image mosaic: gravelpit_mosaic.tif 

▪ EPSG: 32632 (UTM zone 32 north/WGS84) 

⚫ Input ports of the Export DEM operator: 

▪ DEMName: output file for the DSM: gravelpit_dsm.tif 

▪ EPSG: 32632 (UTM zone 32 north/WGS84) 

As you start the process, your final model should look like this:  

 

 Hint 1: Use the UAV Layout 

If your focus is processing UAV data, think about using the provided UAV layout instead of the default 
layout of ERDAS IMAGINE (File > Layout > GEOSYSTEMS UAV Workflow). Nota that the UAV layout 
contains only the most needed functions, as shown below. 
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Hint 2: Using markers (Coded Targets)Please note that the above described example with the gravel 
pit data does not account for markers. If you are interested in example data for testing markers in an 
UAV workflow, please contact us directly. Thus, the following steps explain how to include markers in 
general: 

1. To print markers for your own project, go to Agisoft Metashape and open the Print Markers 
dialogue (Tools > Markers > Print Markers). The markers are written into a pdf file and they are 
numbered consecutively. The size of the markers depends on the UAV flight height and the focal 
length. The side length of the square target which must be fixed on the ground should not go 
below 90 cm (e.g. the UAV is 80 m above the ground equipped with a 35 mm lens).  

2. The markers must be placed according to photogrammetric rules, their geo-coordinates measured 
and listed in a text file. The column in the marker coordinate file containing the name reference 
must contain the string “target” followed by a space and the number of the coded target (see 
below). 

 

3. In the same way as to define the orientation format you must define the format for the markers. 
Thus, in the ERDAS IMAGINE Toolbox tab open MAGINE UAV > Edit orientation formats.  

4. Create a new format definition in the Orientation Format Editor by clicking the + button, next to 
the Available formats list. This adds a new entry to the format list. Here it is named Markers. 

5. Load the actual marker file to preview and check the format settings. These can still be further 
adapted. Therefore, please see the described settings in the Define Orientation Format 
Processing under Step 5., 6. and 7. 
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6. Click Save & Close to save all modified settings. 
7. As reference spatial model, consider the example on page 11. 

 


